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Resolved issues: QuarkXPress 2019 
– March 2020 Update (15.2.1) 

Following is a list of issues resolved in QuarkXPress 2019 – March 2020 Update 

(15.2.1). Note that the following is not an exhaustive list of all fixes in this version. 

RESOLVED: Vector EPS images having objects placed at the edges appear clipped •

at the edges on importing in QuarkXPress. (89680, since v2018) 

RESOLVED: (Windows only): Measurement palette should be horizontally •

resizable. (40279, since v7) 

RESOLVED: The default pasteboard color is not in sync with the selected color •

theme. (117067, since v2019 15.2) 

RESOLVED: (Windows 8.1 OS only): Rulers are not visible in the dark theme. •

(121167, since v2019 15.2) 

RESOLVED: Color profiles in the QuarkXPress default digital color source setup •

changes while performing some document operations, due to which the colors 

appear corrupted. (119256, since v2019) 

RESOLVED: Font style appears blank for some fonts in case of specific user •

names. (118260, since v2018) 

RESOLVED: Memory leak occurs while performing different layout operations. •

(116904, since v2019) 

RESOLVED: (Mac only): Width and height controls are missing for anchored •

items in the vertical measurement palette. (109371, since v2018 14.0) 

RESOLVED: Tabbed text is not aligned properly in case of right tabs and justified •

alignment while opening version 2015 created projects. (121740, since v2016) 

RESOLVED: QuarkXPress crashes while opening specific Mac created documents •

that have a corrupt font list handle. (124418, since v2015) 

RESOLVED: PDF export fails if it contains a hyperlink text having round •

parentheses. (124100, since v2018) 

RESOLVED: (macOS Catalina only): Text flow version does not get updated after •

opening a legacy version project by holding down the Option key and saving in 

the current version. (126350, introduced in macOS Catalina) 

RESOLVED: (macOS Catalina only): Modified images do not get reimported on •

opening a project by holding down the Command key. (126360, introduced in 

macOS Catalina)
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Resolved issues: QuarkXPress 2019 
– January 2020 Update (15.2) 

Following is a list of issues resolved in QuarkXPress 2019 – January 2020 Update 

(15.2). 

RESOLVED: Glyph shapes were outputted incorrectly in specific TrueType fonts •

while converting from TrueType to Type1 during Postscript generation. (5436, 

since v9) 

RESOLVED: (Mac only): Go to URL does not work in ePub opened in iBooks. •

(6207, since v2016) 

RESOLVED: Performance issue occurs during typing or while performing layout •

operations at different zoom levels if there is a scaled PDF image in the 

background. (28306, since v2017) 

RESOLVED: (Mac only): In QLA Client, the Client machine IP is displayed as •

127.0.0.1 instead of the actual IP of the client machine. (53318, since QLA v4.5) 

RESOLVED: Some chapters in a book were lost after closing and reopening the •

book. (61855, since v2018) 

RESOLVED: Cell grids were not imported correctly on importing merged cells •

from Excel files. (98558, since v2019 15.0) 

RESOLVED: (Windows only): Tab ruler used to flicker while zooming. (100093, •

since v2019 15.0.2) 

RESOLVED: Specific PDF files having referenced TrueType version of •

TimesNewRoman font (which does not have a space character in the font name) 

does not import or output correctly. (103097, since v9) 

RESOLVED: (Mac only): Text in Type1 fonts was not rendered on opening •

specific projects. (103452, since v2019 15.0) 

RESOLVED: (Windows only): Faux Italic gets applied on replacing Times New •

Roman Italic font with Magneta Thin Italic font through Usage dialog for the 

footnote text. (104600, since v2016) 

RESOLVED: (Windows only): Cell color applied by drag and drop from the color •

palette was not retained on copy-pasting a table. (108107, since v2019 15.0) 

RESOLVED: (Mac only): Some key commands were messed up in German and •

Swiss German language. (109192, since v2019 15.0) 

RESOLVED: (Mac only): QuarkXPress crashes on clicking on the tab ruler after •

invoking and closing the Story Editor. (109467, since v2016) 



RESOLVED ISSUES: QUARKXPRESS 2019 – JANUARY 2020 UPDATE (15.2)

RESOLVED: Hide object does not work if the Hide object applied box is placed •

on top of the initially hidden box. (109885, since v2019 15.1.1) 

RESOLVED: Hyperlinks were outputted incorrectly in PDF. (110599, since v2019 •

15.1.1) 

RESOLVED: (Mac only): Parent folder is applied as an offline image on opening •

the project after deleting the offline image. (110825, since v2018) 

RESOLVED: QuarkXPress crashes while typing footnote text if a new page is •

being added during text insertion. (112768, since v2017) 

RESOLVED: Items do not appear output if hyperlinks and interactivities are •

applied on the same box. (112942, since v2019 15.1.1) 

RESOLVED: Provide modifier keys in the context menu options for Style sheets •

in the Style sheets palette. (6733, since v2016) 

RESOLVED: (Windows only): The grids at the cell or table edges are not drawn •

properly in case of merged rows, columns or cells. (86131, since v2019 15.0) 

RESOLVED: Multiple strings were displayed incorrectly in the Korean language •

in QuarkXPress. (94717, since v2019 15.0) 

RESOLVED: HTML 5 publication generates single-pixel Google images even after •

exporting by disabling Google Analytics. (97126, since v2018) 

RESOLVED: (Mac only): Specific TrueType fonts are not enumerated properly if •

installed at the default location. (107320, since v2017) 

RESOLVED: Plain, Bold, Italic tags were not interpreted correctly while •

importing XPress Tags if the following tag is a mutually exclusive tag. (108283, 

since v2018) 

RESOLVED: There were performance issues while moving multi-selected objects •

if the project and images placed over the network. (110128, since v2018) 

RESOLVED: QuarkXPress 2019 hangs on opening specific legacy version created •

projects containing tables. (110370, since v2019 15.1) 

RESOLVED: Autofit Rows can be resized to a height smaller than the maximum •

Height on resizing the table or cells. (114373, since v2019 15.1) 

RESOLVED: Mail Merge JavaScript Sample does not work correctly if the CSV •

has ‘\r’ (Carriage Return) as line endings. (117852, since v2018) 

RESOLVED: (Mac only): QuarkXPress Spotlight filter crashes while saving specific •

projects containing multiple style sheets. (118084, since v2019 15.0) 

RESOLVED: (macOS 10.15 only): QuarkXPress crashes while resizing the glyph •

palette if any glyph is selected in the palette. (118164, since v2019 15.1)
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Resolved issues: QuarkXPress 2019 
– December 2019 Update (15.1.2) 

Following is a list of issues resolved in QuarkXPress 2019 – December 2019 Update 

(15.1.2). 

RESOLVED: (macOS Catalina only): Content is not imported from the Word files •

on specific machines. (109325, introduced in macOS Catalina) 

RESOLVED: (Mac only): PDF Export fails on specific machines where a large •

number of fonts are installed in multiple sub-folders and the font file path is 

long. (109635, since v2019 15.1.1) 



RESOLVED ISSUES: QUARKXPRESS 2019 – NOVEMBER 2019 UPDATE (15.1.1)
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Resolved issues: QuarkXPress 2019 
– November 2019 Update (15.1.1) 

Following is a list of issues resolved in QuarkXPress 2019 – November 2019 Update 

(15.1.1). Note that the following is not an exhaustive list of all fixes in this version. 

RESOLVED: Text is not calced properly on applying a different master page •

having different page grid values, if ‘Lock to Page Grid’ is applied on the text. 

(5164, since v2016) 

RESOLVED: Text is not calced properly while typing in some specific projects •

containing a multicolumn-linked text chain having anchored images and 

paragraph rules. (5168, since v2016) 

RESOLVED: The color name in the source project changes on exporting text as •

XPress Tags. (6399, since v8) 

RESOLVED: (Mac only): QuarkXPress crashes while hyphenating or spell-•

checking text on Case Sensitive OS. (6563, since v9) 

RESOLVED: (Windows only): Unable to view the complete file name/full file path •

in the File menu, if the project has a long file name/path name. (31956, since 

v7) 

RESOLVED: In specific cases, picture resize handle is not visible due to which •

the user is unable to resize the picture. (34452, since v10) 

RESOLVED: (Windows only): PCX should be removed from the list of supported •

file types in the Import Picture dialog. (40646, since v10) 

RESOLVED: Export as PDF fails if any URL-based hyperlink is applied in the •

project that contains round parenthesis. (45202, since v2018) 

RESOLVED: QuarkXPress crashes while opening libraries created in v7 ~ v9 •

having grouped/multi-selected items on Windows OS; while on Mac OS, only 

the item on the topmost stack in the group is retained while opening such 

libraries. (52762, since v2018) 

RESOLVED: QuarkXPress crashes on importing XPress Tags file having an •

invalid encoding tag. (58115, since v10) 

RESOLVED: (Mac only): In specific cases, the AppleScript ‘PDF output style’ •

clause is not recognized if the Word Filter XT is enabled. (59308, since v2018) 

RESOLVED: The table grid does not get applied on the top and right sides of •

selected table cells. (86050, since v2019) 
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RESOLVED: (Windows 10 OS only): Auto Update routine brings up a useless error •

message while checking for updates if the BITS service has not been started 

beforehand. (86896, since Quark Update 2.0) 

RESOLVED: QuarkXPress crashes while undoing scaling of an object having •

drop shadow applied after performing ‘Exporting as Image’. (93175, v2019) 

RESOLVED: (Mac only): Float input is not accepted in the CMYK color values •

while creating a new color in OS languages where a comma is used as decimal 

separator. (93314, since v2017) 

RESOLVED: 16 Bit images are rendered as blank when applying/importing with •

the specific color profiles. (93604, since v10) 

RESOLVED: Hyperlinks containing a hyphen character do not show up correctly •

in Acrobat for the PDFs created in QuarkXPress. (93727, since v9) 

RESOLVED: XPress Tags files created v3 ~ v6 containing a paragraph language •

tag cannot be imported in QuarkXPress, an ‘invalid tag’ error is displayed. 

(94386, since v10) 

RESOLVED: Table row height does not match with an InDesign document •

importing an IDML file in QuarkXPress if there is some overflowed text in a cell. 

(94883, since v2019 15.0.1) 

RESOLVED: Rubi cannot be applied on specific Hiragana characters using Rubi •

dialog; the base text gets deleted instead. (95826, since v2016) 

RESOLVED: (Mac only): The keyboard shortcut for Bold/Italic does not work with •

the Greek language keyboard. (97708, since v2019 15.0.1) 

RESOLVED: (macOS Catalina only): Style sheet keyboard equivalents are not •

properly visible in the style sheet palette. (97983, introduced in macOS Catalina) 

RESOLVED: Key command for Italic is ignored for specific Myriad Pro Plain font •

styles, even when their corresponding italic font style is available. (98124, since 

v2019 15.0.1) 

RESOLVED: None or zero point table stroke width is incorrectly changed into •

hairline while importing an IDML file in QuarkXPress. (98169, since v2019) 

RESOLVED: (Windows only): Menus of Kerning Pairs and Font Tracking Tables •

are disabled in the Edit menu; and sometimes the Hanging Characters menu is 

also disabled in the Edit menu. (98234, since v2019 15.0.0) 

RESOLVED: (Windows only): Unable to scroll through the font list using the key •

commands for previous font/next font if recently used font setting is enabled. 

(99183, since v2017) 

RESOLVED: Picture fitting options do not work while importing/dragging and •

dropping images via spring loading. (102114, since v2019 15.0.0) 

RESOLVED: Bounding box for specific EPS files is created incorrectly while •

importing them in Letter/paper size layouts. (103076, since v2019 15.0.1) 

RESOLVED: (Windows only): Font styles names are displayed incorrectly in the •

font style menus of measurement palette, usage dialog, and in the style sheet 

description in East Asian languages. (103104, since v2018) 
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RESOLVED: Referenced EPS image renders as junk/courier when the total •

number of font folders under ~/Library/Fonts/exceeds 256. (103795, since 

v2018) 

RESOLVED: There is a performance delay while invoking PDF output dialog box, •

and while creating PDF if there are Item Styles in specific projects. (104618, 

v2019 15.1) 

RESOLVED: Update Missing Images’ JavaScript sample does not scan sub-folders •

for missing images, and it does not work properly if a different page of the PDF 

is imported. (104949, since v2018) 

RESOLVED: Existing picture scale and position values are not retained on •

dragging and dropping the same image after the image has been removed once. 

(107684, since v2019 15.0.0) 

RESOLVED: PDF/UA Accessibility Certification fails if endnotes are present in •

the layout and ‘Export Endnotes as Hyperlinks’ option is checked in the PDF 

Export options. (108416, since v2019 15.1) 

RESOLVED: (Windows only): The key commands for navigating the text cursor to •

the start of the previous word, next word, previous paragraph, next paragraph 

do not work. (103256, since v2019 15.1)
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Resolved issues: QuarkXPress 2019 
– October 2019 Update (15.1) 

Following is a list of issues resolved in QuarkXPress 2019 – October 2019 Update 

(15.1). 

RESOLVED: Page number goes missing while outputting a book. (43008, since •

v2018) 

RESOLVED: Specific EPS images created in an older version of Adobe Illustrator •

does not import with correct bounding boxes, resulting in shifting of the 

content and incorrect output. (39089, since v2018) 

RESOLVED: Halftone information is displayed in the PDF outputted directly •

with Callas Distiller. (42464, since v2018) 

RESOLVED: Postscript Error occurs on output with native transparency for •

specific PDF images having contents with 0 pt width and PDF images scaled 

down to 60%. (47157, since v2018) 

RESOLVED: Postscript Error occurs on output with specific fonts that have font •

embedding restrictions. (90342, since v9) 

RESOLVED: Glyphs are not downloaded in the Postscript and font is not •

downloading correctly if the project contains social media glyphs from specific 

font. (94909, since v2019 15.0) 

RESOLVED: QuarkXPress hangs during launch if the Documents folder has •

restricted access. (96723, since v2019 15.0) 

RESOLVED: Postscript Error occurs while embedding specific Type1 Postscript •

font using Callas/Acrobat Distiller. (93594, since v2018) 

RESOLVED: The bézier point tool flickers continuously while creating Bezier •

points. (94304, since v2015) 

RESOLVED: Item Knockout Drop shadow applied on an object is not retained •

on exporting as an image. (93110, since v2019 15.0.1) 

RESOLVED: Images extracted from the PDF generated from QuarkXPress are •

always rotated at 180 degrees. (51180, since v2017) 

RESOLVED: Text boxes extend beyond the spread height on converting a •

picture box containing a .ai file to a native object. (5690, since v2016) 

RESOLVED: White color text stroke displays with overprint on outputting as •

PDF. (37129, since v2017) 
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RESOLVED: EPS having reference fonts is rendering as junk if fonts are installed •

for the current user. (95630, since v2018) 

RESOLVED: (Windows Only): Many options under Item menu appear grayed out •

for multi-selected items in Finnish and Traditional Chinese language. (101950, 

since v2018) 

RESOLVED: Projects containing text with opacity, box color and drop shadow •

having ‘Item knockout Drop Shadow’ option enabled are outputted incorrectly. 

(95325, since v2015) 

RESOLVED: Table cell attributes like color, shade, opacity are synced to the •

continued headers in the first instance on resizing any instance. (86389, since 

v2019 15.0) 

RESOLVED: Cells in the continued headers in the other instance are also •

combined on resizing any instance if the corresponding row is merged in the 

first instance. (86392, since v2019 15.0) 

RESOLVED: Cell grids are not applied correctly on merging table cells having •

different grids applied to the cells. (87960, since v2019 15.0) 

RESOLVED: QuarkXPress crashes on right-clicking in a selected table row when •

a picture cell is in focus. (96276, since v2018) 

RESOLVED: QuarkXPress crashes randomly while performing different •

operations like hovering the mouse over a picture cell in tables, or on opening 

Edit Original, etc. (97112, since v2019 15.0) 

RESOLVED: Border attributes such as color and style applied to Tables are lost •

on opening legacy files in QuarkXPress 2019. (94164, since v2019 15.0) 

RESOLVED: QuarkXPress crashes on importing specific XPress Tags files having a •

large number of index entries. (98779, since v2019 15.0) 

RESOLVED: (Windows Only): Hanging Characters in the layout appear truncated •

in QuarkXPress 2019. (91205, since v2019 15.0) 

RESOLVED: Text selection is not in sync with the cursor movement if Hanging •

Characters are applied on the text. (92105, since v9) 

RESOLVED: QuarkXPress crashes on clicking on the alert ‘This shape too few •

points’ after invoking the context menu for a bézier point. (94308, since v2019 

15.0) 

RESOLVED: Words containing either a discretionary hyphen, zero-width space •

or a word joiner cannot be searched using Find/ Change. (94579, since v2016) 

RESOLVED: (Windows Only): There is a performance delay while modifying •

applied font families. (38030, since v2018) 

RESOLVED: (Windows Only): There is a performance delay while modifying •

applied font styles. (38025, since v2018) 

RESOLVED: (Windows Only): There is a performance delay while modifying •

applied fonts if recently used font preference is enabled. (93994, since v2017) 

RESOLVED: Line width does not appear properly at specific zoom levels. (98262, •

since v2018) 
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RESOLVED: Selecting the first entry in Organization drop-down does not •

populate the subsequent child entries in the Publication drop-down of the App 

Studio Publishing Palette. (94480, since v2018) 

RESOLVED: Slide Previews are not displayed for Slideshows in HTML5 Palette in •

localized languages. (94283, since v2019 15.0) 

RESOLVED: NEDD dialogs of all assets shift towards the right edge of the screen •

while increasing/decreasing the dialog vertically. (88354, since v2017) 

RESOLVED: (Windows 10 - version 1809 only): QuarkXPress crashes on inserting •

Indic text in TTC fonts; TTC fonts installed for the current user are not collected 

during Collect for Output. (88796, Introduced by Microsoft Windows 1809 

update) 

RESOLVED: EPS files having embedded fonts are imported and outputted •

incorrectly from QuarkXPress. (94666, since v2018) 

RESOLVED: Custom created Dashes & Stripes are not enumerated in the style •

drop-down under the border tab of Item Find/Change. (34678, since v8) 

RESOLVED: Add support for auto-grow text boxes in Item Styles. (55885, since •

v2019 15.0) 

RESOLVED: Add support for last line indent for paragraphs in Table of Contents. •

(6829, since v7) 

RESOLVED: Add support to export endnotes as hyperlinks in PDF. (6935, since •

v2015) 

RESOLVED: Telephone number links specified through the Go to URL •

hyperlinks do not work in HTML5 output. (58870, since v2017) 

RESOLVED: Specific IDML documents that have any item on the pasteboard •

with width and height dimensions as 0 do not open in QuarkXPress. (52857, 

since v2017)
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Resolved issues: QuarkXPress 2019 
– September 2019 Update (15.0.2) 

Following is a list of issues resolved in QuarkXPress 2019 – September 2019 Update 

(15.0.2). 

RESOLVED: (macOS only) The key commands to apply Bold/Italic styling do not •

work in localized languages. (96147, since v2019 15.0.1) 

RESOLVED: (Mac only): An ‘Access denied error’ is displayed while saving a file, •

and a ‘File is locked’ error is displayed while opening a file with the slash 

character in its file name. (94182, since v2019) 

RESOLVED: (Windows only) The order of menu items in the Edit menu is •

incorrect in Italian and Czech languages. (95198, since v2019 15.0.1) 

RESOLVED: (Mac only): Slide preview does not display in the Slideshow in •

HTML5 Palette in localized languages. (94283, since v2019) 

RESOLVED: QuarkXPress crashes on drawing a flex container if the application •

is launched with QuarkXPress 2018 preferences. (94923, since v2019) 

RESOLVED: The mouse pointer for any tool flickers continuously while moving •

the mouse on the layout if the measurement palette is in the undocked state. 

(94304, since v2015) 

RESOLVED: Reset the default guide color to support legacy preferences in digital •

layouts. (95594, since v2019) 

RESOLVED: (macOS 10.15 only): QuarkXPress application does not resume after •

printing. (94143, since v2019) 

RESOLVED: (macOS 10.15 only): QuarkXPress hangs on creating a new print •

output style. (94542, since v2019) 

RESOLVED: (macOS 10.15 only): QuarkXPress crashes on closing a project after •

quitting, and relaunching the application once. (95057, since v2019)
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Resolved issues: QuarkXPress 2019 
– September 2019 Update (15.0.1) 

Following is a list of issues resolved in QuarkXPress 2019 – September 2019 Update 

(15.0.1). Note that the following is not an exhaustive list of all fixes in this version. 

RESOLVED: QuarkXPress crashes during flattened output of large dimensioned •

high-resolution transparency PSD images along with another high-resolution 

image. (4118, since v9) 

RESOLVED: Gradients overprint in all output setups in native/flatten output if •

the text has an overprint attribute applied to it. (4666, since v2016) 

RESOLVED: Unable to change the font size in Adobe Digital Editions for Reflow •

ePubs created from QuarkXPress. (4753, since v2015) 

RESOLVED: Drop shadow gets orphaned from the parent box on •

inserting/deleting the pages before the spread page containing the drop shadow 

item. (4814, since v2016) 

RESOLVED: Deselecting the background layer of a PSD layered image instance •

deselects the background layer of other instances of the same image. (4914, since 

v2017) 

RESOLVED: The character shading offsets are not reset on applying character •

shading on multiple lines of text. (4985, since v2017) 

RESOLVED: Text overflows on importing a Word file having a table and the first-•

line indent applied. (5027, since v2017) 

RESOLVED: The title bar of the library palette becomes invisible and it cannot •

be dragged downwards, once it is has been dragged above the QuarkXPress 

menu bar. (6105, since v2016) 

RESOLVED: (Windows only): A spot color having a Korean name in a •

QuarkXPress project gets exported as two spot colors in a PDF output. (6340, 

since v10) 

RESOLVED: Modified custom color does not get updated when an image is •

colorized with a custom color. (6360, since v2015) 

RESOLVED: (Windows only): The key command for the conditional style marker •

shortcut does not work in the Swiss German language. (7184, since v2016) 

RESOLVED: QuarkXPress crashes on opening IDML files having more than 2000 •

pages. (19680, since v2017) 
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RESOLVED: (Mac only): Image does not render in the layout after enlarging the •

high resolution large-sized 1-Bit images. (21102, since v2017) 

RESOLVED: (Mac only): Incorrect text gets replaced on converting confirmed •

Hangul text into Hanja text through Korean IME if the text contains an indent 

here, discretionary return or a conditional style marker. (28074, since v2017) 

RESOLVED: Fonts are mapped to incorrect font styles on importing a Word file •

or RTF file in QuarkXPress. (29685, since v2016) 

RESOLVED: (Windows only): Buttons on the Measurements Palette get corrupted •

when they are displayed in tristate on high DPI displays. (32757, since v2017) 

RESOLVED: EPS images of height less than 1.06 mm cannot be imported in •

QuarkXPress. (33810, since v2018) 

RESOLVED: QuarkXPress hangs on moving or pressing right-click on continued •

tables in IDML created projects. (36456, since v2017) 

RESOLVED: QuarkXPress crashes or is rendered blank if a higher DPI/ large •

dimensions image is imported. (37708, since v2017) 

RESOLVED: The entries in Index palette get scrolled to the top of the palette on •

expanding/ closing the page references of an index entry. (38098, since v2016) 

RESOLVED: Changes in Fraction/Price settings in Preferences are not retained •

after relaunching QuarkXPress. (40951, since v2015) 

RESOLVED: Non-rectangular boxes appear as rectangular boxes in output if •

picture zoom interactivity is applied. (42859, since v2016) 

RESOLVED: Style sheet keyboard equivalents get corrupted or are lost on •

opening Mac created projects on Windows. (48134, since v10) 

RESOLVED: (Mac only): PDF certification/ verification fails if the name of the •

folder in which PDF is saved contains Unicode characters. (48664, since v2018) 

RESOLVED: Old and new Pantone colors render differently but output as the •

same color. (48849, since v2017) 

RESOLVED: (Windows only): The key command for Non-Breaking En Dash does •

not work in the Swiss German OS language. (52164, since v2017) 

RESOLVED: Unable to search/ replace discretionary hyphen using Find/ Change. •

(52255, since v2018) 

RESOLVED: (Windows only): Romanian words having ș, ț, Ș, Ț do not hyphenate •

in QuarkXPress. (55060, since v8) 

RESOLVED: (Mac only): Layers created using AppleScript have an extra junk text •

in the given name. (56462, since v2016) 

RESOLVED: Raster EPS image resolution is always displaying as 72 dpi. (59799, •

since v2015) 

RESOLVED: The shirorekha of the vowels: e (U+09c7), ai (U+09c8), o (U+09cb), •

au (U+09cc) are not joint to rest of the characters in the Bengali words when 

these characters are in the middle of the word. (59813, since v2018) 

QUARKXPRESS 2019 KNOWN AND RESOLVED ISSUES | 13



RESOLVED ISSUES: QUARKXPRESS 2019 – SEPTEMBER 2019 UPDATE (15.0.1)

RESOLVED: Text runaround gets ignored if any item on the layout is duplicated •

using Option+ Drag. (61169, since v9) 

RESOLVED: (Mac only): Text highlight color cannot be changed. (61238, since •

v2018) 

RESOLVED: (Windows only): A truncated icon is displayed in the Picture tab near •

the mask drop down in the measurements palette after creating a table having a 

picture cell. (85918, since v2018) 

RESOLVED: (Mac only): ‘Large size’ display setting for Measurements palette is •

not saved on relaunching the application, on changing the measurement palette 

orientation and on switching between the palette sets. (86816, since v2016) 

RESOLVED: (Mac only): Unable to scroll within the palette using a scroll bar or •

mouse if the palette is docked. (86993, since v2018) 

RESOLVED: (Windows only): The key command for inserting an inch mark does •

not work in the Swiss German language. (88039, since v2017) 

RESOLVED: The drop-down combo boxes in the Table Style dialog display a •

validation error on losing focus in a blank/ mixed state; unable to tab from it 

thereafter. (88187, since v2019) 

RESOLVED: (Windows 10 - version 1903 only): The key command for Scale •

picture to Fit Box does not work. (88423, Introduced by Microsoft Windows 

1903 update) 

RESOLVED: GWG Patch 16.8, 16.9 and 16.10 patches are outputting incorrectly •

in native transparency output. (88806, since v2019) 

RESOLVED: Stylistic Set applied through style sheet dialog is not retained on •

confirming OpenType Styles dialog; thereafter Update button is also not enabled 

in the style sheet palette on applying any OpenType style locally. (88871, since 

v2019) 

RESOLVED: Layout checkbox in the Scale palette cannot be unchecked, as a •

result of which layouts cannot be scaled. (89029, since v2019) 

RESOLVED: An invalid email address alert is displayed if there are special •

characters in the email address in Send Feedback dialog. (89110, since v2018) 

RESOLVED: (Windows only): QuarkXPress crashes on building index if the index •

palette is already not invoked; style sheet icons are missing for the paragraph 

style sheet in the build index dialog. (92322, since v2019) 

RESOLVED: Table border grids values are not retained on opening legacy •

documents in QuarkXPress. (89170, since v2019) 

RESOLVED: (Windows only): Telugu text gets deleted while typing via Lipika •

IME. (89439, since v2018) 

RESOLVED: (Mac only): Projects which are saved / downsaved via AppleScript •

cannot be opened in QuarkXPress. (89730, since v2016) 

RESOLVED: Hyperlink for some Cross-references in some specific projects may •

not work in PDF output. (8999, since v2018) 
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RESOLVED: QuarkXPress projects having an EPS file are outputting partially on •

outputting immediately after opening the project. (90729, since v2017) 

RESOLVED: Unable to change the cell width via measurements palette for tables •

imported from Excel file. (92792, since v2019) 

RESOLVED: Text hyphenates at a horizontal ellipsis, a two-dot leader and a •

horizontal bar even when Auto Hyphenation is unchecked in Non-Unicode 

fonts in Indic languages. (93045, since v2018) 

RESOLVED: QuarkXPress crashes on opening/ saving a project if the file name •

begins with a # character. (93411, since v2019) 

RESOLVED: The Cancel button is not aligned correctly in the Table Styles Dialog. •

(89164, since v2019) 

RESOLVED: High-resolution images having picture zoom interactivity applied •

on it are not displayed with the correct size in digital output (101730, since 

v2019) 

RESOLVED: (Mac only): The palette resize pointer does not display correctly for •

docked palettes. (89744, since v2017) 

RESOLVED: An incorrect alert for ‘Faux Bold Transparency’ is displayed on •

outputting a project if it has a text box with text in a bold font and any type 

style applied and an image partially overlaps the text box, or drop shadow of an 

item partially overlaps/ is close to the text box. (61398, since v2018) 

RESOLVED: Only font name should be displayed in the Usage dialog if the font •

is available on the system and no faux bold/ italic is applied to it. (61437, since 

v2018) 

RESOLVED: The plain, bold and italic buttons should be removed from the •

palettes and dialogs in QuarkXPress. (61449, since v2018) 

RESOLVED: (Windows only): Program language menu should be added to the •

Edit menu and application should restart automatically on changing program 

language. (90341, since v2019)
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Resolved issues: QuarkXPress 2019 
– (15.0) 

Following is a list of issues resolved in QuarkXPress 2019 – (15.0). Note that the 

following is not an exhaustive list of all fixes in this version. 

RESOLVED: (Mac only): Books cannot be opened through the ‘Open a Recent •

Project’ option in the Welcome Screen. (76579, since v10) 

RESOLVED: Some IDML documents do not open when a corrupted or •

unassigned object is placed on the pasteboard area with “0” height and width 

value. (52857, since v2017) 

RESOLVED: (macOS Mojave only): Unable to save, ‘File is already open for •

writing’ alert is displayed while saving files on Windows Server using SMB 

Protocol. (59231, Introduced by macOS Mojave update) 

RESOLVED: (macOS Mojave only): ‘This Project is locked’ alert is displayed while •

opening any project from a Mac shared folder when the view in Open dialog is 

set to Column view. (45211, Introduced by macOS Mojave update) 

RESOLVED: Exporting a box as an image always creates a 72 DPI image. •

(261325, since v2016) 

RESOLVED: (Windows 10 - version 1809 only): QuarkXPress crashes while •

inserting Indic text in Indic fonts if fonts are installed at the user level. (52768, 

Introduced by Microsoft Windows 1809 update) 

RESOLVED: (Windows 10 - version 1809 only): Unable to Collect TrueType fonts •

using Collect For Output if fonts are installed at the user level. (53147, 

Introduced by Microsoft Windows 1809 update) 

RESOLVED: (Mac only): AppleScripts placed in the Root Library folder are not •

displayed in the Script menu in QuarkXPress. (55312, since v2018) 

RESOLVED: (Windows only): Marquee is not drawn correctly for the zoom-in •

area, as a result, an incorrect area gets zoomed in. (47539, since v7) 

RESOLVED: CMYK Colors applied with transparency are color managed and get •

converted to RGB while outputting in AsIs output setup in flattening mode. 

(32066, since v2017) 

RESOLVED: (Windows only): Quark CEF Renderer does not quit when •

QuarkXPress crashes, as a result, a lot of CPU gets consumed. (58071, since 

v2018) 
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RESOLVED: (Mac only): Serial Number is not displayed for the installed •

QuarkXPress application in the Quark Update Preferences dialog. (85555, since 

v8) 

RESOLVED: RGB colors values do not display in levels in Edit Color dialog •

(4813, since v7) 

RESOLVED: QuarkXPress crashes when version 4 “Black and White.icc” color •

profile is used in output or soft proofing/ proof output. (10340, since v2015) 

RESOLVED: Performance issue occurs while panning imported vector and raster •

images on 4K and Retina display machines. (43042, since v2017) 

RESOLVED: Fonts are replaced with Courier font while outputting with font •

embed settings in case the user name contains an accented character (53252, 

since v2018). 

RESOLVED: Table of Contents is not structured correctly while exporting to an •

accessible PDF. (31348, since v2018) 

RESOLVED: Picture Boxes added as callout anchors inside table cells are not •

added to reading order tag tree (47255, since v2018) 

RESOLVED: PDF/A-2u, PDF/A-2b and PDF/A-3b verification/certification fail on •

verifying QuarkXPress projects having gradation and text. (29800, since v2018) 

RESOLVED: Callas Distiller takes more time to distill/ output as compared with •

JAWS. (4562, since v2018) 

RESOLVED: Reference to footnotes/endnotes are not enclosed in <Ref> structure •

element in tagged PDF output. (51120, since v2018) 

RESOLVED: Performance delay occurs while generating PostScript Output from •

QuarkXPress. (47694, since v2018) 

RESOLVED: Unable to import an EPS file and ‘Unknown Error’ is displayed if •

the user name has any special character in it. (4096, since v2016) 

RESOLVED: (Mac only): Unable to change the leading from absolute/ •

proportional leading to auto leading through style sheet dialog in localized 

languages. (56665, since v2018)
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Known issues as of QuarkXPress 
2019 

Following is a list of known issues in QuarkXPress 2019. 

(Windows only): Old project preview is rendered and project window displays as a •

gray-colored patch while performing different layout operations in projects 

containing heavy images. The rendering issue is temporary and does not impact 

the workflow. (49094) 

(Windows only): There is a slight performance delay during font replacement •

while opening projects containing missing fonts. (55189) 

(Windows only): Text appears to flicker while typing text in shared text boxes •

(60762) 

Box reference point does not work on a shared content instance. (49872) •

(Windows only): Live preview of the 9-Point Reference Grid icon does not work •

while rotating an item using a mouse. (60768) 

9-Point Reference Grid is not integrated with Item Styles. (37299) •

Auto Grow text box has the following limitations. It is not integrated with •

Vertical Story, Column Flow, Runaround, Justified Alignment. (85942) 

When you scale Tables using Item Scale XT, Grid Width is not scaled. (55881) •

Table presets should be shown in Replace With drop down upon deleting a •

custom table style. (53398) 

In case, Row alignment for a Flex container is set to Start and user overrides its •

alignment for any specific item by selecting Self-Align, then the Flex output will 

differ on different browsers. (52608) 

Workaround: Wrap needs to be turned off for the container. •

In case, there are Flex items having multiple grow and shrink values applied in a •

container, then wrap does not work on the layout even when the total number 

of items width exceeds 100%. (51863) 

In case, Grow and Shrink are applied to two Flex items in a container and a Flex •

container is created by selecting the second item, then the first item disappears 

from the layout. (59620) 

Workaround: Apply Shrink value 1 to the newly created container. •

Bullet and Numbering style applied on the Flex layout does not display in Flex •

output. (58690) 
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The height of Flex items increases on wrapping if minimum width/ height is •

defined for those items, and it is a layout rendering issue. (42550) 

Workaround: Remove Minimum height from Flex container. •

Parallax Effect does not work works viewing HTML5 output on Mobile browsers •

and in HTML5 Publication on desktop browsers. (55555) 

Item size gets reduced on creating a Flex container from the context menu for •

any selected item. (50503) 

Workaround: Select a box and change its width to 100% but this •

workaround does not work on creating a Flex container by selecting 

multiple items. 

Go to Page Interactivity does not work in HTML5 Output. (48354) •

Workaround: Apply Page Hyperlinks. •

Few of the advanced typography features are ignored during HTML5 output. •

(40475) 

Tables column width changes during IDML import and table body rows are •

displayed as overflown. (59601) 

(macOS Catalina only): Export as Kindle option is not available in QuarkXPress. •

(101155) 
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Legal notices 

©2022 Quark Software Inc. and its licensors. All rights reserved. 

Quark, the Quark logo, QuarkXPress, and QuarkCopyDesk are trademarks or 

registered trademarks of Quark Software Inc. and its affiliates in the U.S. and/or 

other countries. All other marks are the property of their respective owners.


	Resolved issues: QuarkXPress 2019 – March 2020 Update (15.2.1)	⁠
	Resolved issues: QuarkXPress 2019 – January 2020 Update (15.2)	⁠
	Resolved issues: QuarkXPress 2019 – December 2019 Update (15.1.2)	⁠
	Resolved issues: QuarkXPress 2019 – November 2019 Update (15.1.1)	⁠
	Resolved issues: QuarkXPress 2019 – October 2019 Update (15.1)	⁠
	Resolved issues: QuarkXPress 2019 – September 2019 Update (15.0.2)	⁠
	Resolved issues: QuarkXPress 2019 – September 2019 Update (15.0.1)	⁠
	Resolved issues: QuarkXPress 2019 – (15.0)	⁠
	Known issues as of QuarkXPress 2019	⁠
	Legal notices	⁠

